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PRO TIP
Packet-sniffing is a 
privileged affair. However, 
Wireshark doesn’t need 
elevated privileges unless 
capturing traffic.

A network protocol analyser lets you peer inside 
your network and see what’s really happening 
on it. Its deep packet inspection allows you to 

see the chunks of data, called “packets”, moving 
across your network and view the data inside them. 
And, if that data isn’t encrypted, you’ll quickly realise 
how much information is readable by anyone!

We’re going to look at Wireshark, a cross-platform 
desktop network analysis application that was known 
as Ethereal until 2006. There are versions for use with 
GTK and Qt libraries, although the latter is considered 
a less-mature port of the former. They use the  
libpcap packet capture library to capture network 
packets for inspection.

You’ll most likely find a package in your distro’s 
repository – you can choose from command-line, GTK 
or Qt variants. The GTK version on Arch Linux is 
wireshark-gtk; it’s simply wireshark if you’re Debian-
based. The current stable release is 1.12.3, but some 
distros may lag that slightly.

You can run Wireshark as any unprivileged user, but 
it requires elevated privileges to capture packets and 

SEE WHAT’S HAPPENING ON 
YOUR NETWORK.
Looking at the data flowing across your network can be an ethereal experience. You’ll be 
surprised at what you can see when you start snooping...

this is granted to users in the wireshark group. Add 
your user to this group if you want to capture packets 
(you don’t need to do this if you’ll only be analysing 
previously captured packets).

When you launch it, you’re presented with the main 
screen. You can read about the various displays in the 
on-line documentation (press F1, do Help > Contents 
or browse to www.wireshark.org/docs to view the 
User’s Guide – Chapter 3 describes the user 
interface). To begin capturing, choose your network 
interface from the panel on the left-hand side (it’ll be 
called something like eth0 or, if you have Systemd, it 
might be like a more cryptic “enp3s0”) and then press 
the green shark-fin button to begin capturing. 
Captured packets are displayed as they arrive; press 
the red-square button to stop capturing.

You can save your capture if you want to – use File 
> Save or use the toolbar button. As you would expect, 
there’s an option to open a previously saved capture 
file. Users can work with such files without having 
elevated privileges, so they don’t need to be members 
of the wireshark group.

Who’s calling?
Among the various data displayed about a packet is 
its source and destination, which will either be a MAC 
or IP address depending on the protocol layer that the 
packet is from. You might prefer to see recognisable 
names here, especially if you’re on a busy network. 
There are two options for you – either let Wireshark 
use name resolution or provide names yourself.

It may be tempting to use name resolution but this 
has the negative side-effect of polluting your capture 
with the name resolution requests that Wireshark 
would make to a DNS server. It’s disabled by default to 
prevent this but you can enable it on the “Name 
Resolution” preferences page if you want to. However, 
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Wireshark’s default layout 
displays captured packets. 
Click on a packet to see its 
contents organised by 
protocol. You can view 
data bytes in hex or binary.

Keep tabs on your network traffic to see what’s going 
through the wires you’re paying for.
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PRO TIP
You can create rules 
based on captured 
packets for various 
firewalls including 
iptables. Right-click a 
packet and select Tools > 
Firewall ACL Rules. You 
can build rules that either 
accept or drop the 
selected packet.

PRO TIP
Filter expressions are 
described in the User’s 
guide. See section 4.13 
for capture filters and 6.4 
for display filters.

an alternative is to provide names yourself. You do 
this by creating Wireshark-specific “hosts” and “ethers” 
files to map addresses to names in a similar way to 
the system’s own /etc/hosts file and they have a 
similar format. Use your favourite text editor to create 
the file ~/.wireshark/hosts with entries like:
192.168.1.254 router
and ~/.wireshark/ethers with entries like
a2:e4:e6:65:2b:c2 router

You can also add comments – lines beginning with 
the # character are ignored.

In addition to the above, Wireshark will learn 
whatever names it can from captured DNS packets, 
so you might see some names resolve magically even 
if name resolution is disabled and you haven’t 
provided them yourself.

Be promiscuous
Network interfaces normally ignore any data packets 
that aren’t destined for them. This is usually a good 
thing because it removes the overhead associated 
with accepting irrelevant data. Data packets destined 
for a network interface includes the obvious “Unicast” 
data addressed only to it, “Multicast” data sent to 
multiple nodes on the network and “Broadcast” data 
sent to all nodes on the network.

However, data that would not normally be received 
can also be of interest when you are sniffing about 
and you can tell a network interface to accept 
everything that it receives by enabling its so-called 
“promiscuous mode”.

A promiscuous interface will see everything that 
arrives at that interface but that isn’t necessarily 
everything on the network. If it’s connected to a port 
on a network switch then it may only see the traffic 
emitted from that port. So, what you can see also 
depends on where you look.

Wireshark enables promiscuous mode by default, 
but you can control it with a check-box on the 
“capture” page of the Edit > Preferences box.

Sniff, sniff…
OK, so you’ve captured some data. Let’s take a look. 
The first packet captured receives a time-stamp of 
zero and all other packets are time-stamped relative to 
the first. These values are displayed in the “time” field 
by default, but you can change this to regular 
date-time values by selecting View > Time Display 
Format from the menu.

Captures usually contain a lot of data, so the first 
thing worth doing is to apply some filters to make it 
easier to see what’s interesting. The “Filter” box is 
beneath the toolbar and you can enter basic 
expressions to filter what’s displayed (there’s also a 
capture filter but it’s best to capture everything while 
you’re learning how to use it).

To begin, let’s sniff out web browsing activity. Enter 
“http”, the protocol used for web traffic, into the display 
filter box in the toolbar and then press the Apply 
button (you need to use lower case in the filter even 

though the display shows the protocol in upper case). 
The display will then show only that kind of traffic.  
You may also see SSDP packets because they’re 
based on HTTP (it’s is a multicast protocol used by 
UPnP services). You won’t, however, see HTTPS. You 
can resolve these issues by using a filter expression 
like this:
(ssl.record.version >= 0x0300 or http) and not udp.dstport == 
1900

This example demonstrates the display filtering 
language. It accepts the usual comparison and logical 
expressions written using English keywords or C-like 
symbols and you can use parentheses to build 
compound expressions. As you write your expression, 
a drop-down list shows possible values based on 
what you’ve entered. You’ll notice from our example 
that you can’t always use the protocol name but there 
are other tactics you can use like we have done to 
include SSL and exclude SSDP.

Another use for display filtering is to add emphasis 
to captured packets by displaying them in different 
colours according to defined “Colouring Rules”. A 
number of default rules are provided, but you can alter 
them to suit your own requirements (select View > 
Coloring Rules from the menu). You can import and 
export rules and there are user-contributed profiles 
available at wiki.wireshark.org/ColoringRules. The 
Import dialog has a button that imports the Global 
Colour Filter File, which contains the default rules.

Another way to apply colour filters is by 
conversation, or all the traffic between two endpoints 
– the protocol-specific places between which the 
traffic flows, such as the IP address and port at each 
end of the HTTP request made when you browse a 
website. You can colour the conversation that 
includes the selected packet by pressing the Ctrl key 
along with a number key.

You can right-click on a packet and select Follow 
TCP Stream to display the conversation it’s part of. 
This opens a separate window that displays the data 
within the entire bi-directional conversation, but you 
can filter this to view either direction. 

There are other displays that list and categorise 
conversations (Statistics > Conversations) and 
endpoints (Statistics > Endpoints), plus many others 
that you can explore.

Viewing a TCP stream lets 
you see a conversation in 
one piece. Look out for 
those login credentials 
sent in cleartext...
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Sometimes you may want to use a packet 
analyser on a server or other machine where it 
isn’t practical to run a GUI application. Perhaps 

you want to capture packets on the server for later 
analysis with Wireshark back on your desktop, or you 
just want to perform some quick checks right there on 
the server. Command line tools exist to help in this 
regard and Wireshark’s command-line cousin, tshark, is 
one of these.

It’s usually packaged separately so that you can 
install it on servers without the GUI dependencies. 
Debian users should look for the tshark package, 
whereas it’s wireshark-cli on Arch. Capturing has the 
same privilege requirements as the full GUI version 
(be root or add your user ID to the wireshark group).

You can run it straight from the command line and, 
by default, it will list the captured packets to the 
screen. However, it’s more useful to write the capture 
to a file:
$ tshark -i eth0 -w capture.pcapng

Tunnel it
Another way to use tshark is through an SSH tunnel. 
This lets you monitor a remote server in real time with 
Wireshark. It’s a bit convoluted, but goes something 
like this:
$ ssh myserver ‘tshark -f “port !22” -F pcap -w -’ | wireshark -k -i 
-

This assumes that you can log in to the server 
without needing to enter a passphrase (ie your SSH 
agent has cached it). If that isn’t possible, an 
alternative method is to use a named pipe:
$ mkfifo /tmp/myserver
$ wireshark -k -i /tmp/myserver &
$ ssh myserver ‘tshark -f “port !22” -F pcap -w -’ > /tmp/
myserver

The arguments tell tshark to ignore traffic on port 
22, otherwise we’d get the SSH tunnel in our capture, 
and to output in pcap format, because that’s what 
Wireshark expects on standard input. The arguments 

SNOOP WITHOUT A GUI  
WITH TSHARK

given to Wireshark tell it to start capturing immediately 
from standard input.

One thing to consider is that you’ll need to restart 
tshark if you stop the capture in Wireshark. This is 
obviously easier with the named pipe method 
because it doesn’t require restarting Wireshark as well.

When capturing remotely, you can pass parameters 
on the tshark command-line to filter the capture and 
reduce the amount of data passed over the SSH 
tunnel. Both tshark and Wireshark delegate packet 
capture to a separate utility called dumpcap. This is 
the part that runs with root privileges, and you can use 
it directly if you don’t require the post-capture features. 
You can replace tshark on the command-line like this
$ ssh myserver ‘dumpcap -f “port !22” -P -w -’ > /tmp/myserver

The other way to use tshark is to do packet analysis 
directly on the server. You can do this while capturing 
or by reading in a capture file, for which you use the -r 
argument:
$ tshark -r capture.pcapng

You can apply display filters using the -Y argument 
using same syntax as Wireshark. The -f argument we 
used above is for capture filters; this has no effect 
when reading a capture file. There’s also a -R 
argument for a read filter, which discards unwanted 
packets read from a file.

Options by example
tshark has no interactive mode, so you need to know 
in advance what output you want and describe it 
using the command-line options. This is best 
described with an example.

JOHN LANE

Capture file formats

The traditional packet capture file format is 
called pcap and there are lots of applications 
that use it including tcpdump and Wireshark. 
There’s also a next-generation format called 
pcap-ng, and Wireshark, tshark and dumpcap 
use this by default. It’s recommended to use 
the .pcapng file extension for these to 
differentiate them from the .pcap file format.

You must use the pcap format if you’re 
using pipes, because neither Wireshark nor 
tshark can read pcap-ng from a pipe. You’ll 
get an “Unrecognized libpcap format” error 
message if you try to do this; it’s why we 
specified the format in the SSH examples. 
Wireshark includes a utility, editcap, that can 
convert between these formats.

When you need to capture packets from a server, you need a tool that works over SSH…

The Wireshark website is a good reference for information. 
There’s documentation and a question-and-answer 
system that you can use to ask for help.
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$ tshark -i eth0 \
   -f “tcp port 80 or tcp port 443” \
   -f “host www.linuxvoice.com” \
   -w capture.pcapng \
   -z follow,tcp,ascii,1

We’ve broken the command across multiple lines to 
make it more readable. It begins with -i to select 
which interface to capture on. This argument can be 
repeated if you want to capture on more than one 
interface. You can list the available interfaces with 
tshark -D, which outputs a numbered list. You can 
specify interfaces by their name or number.

Next, we provide capture filters. These use a 
different syntax to display filters, which comes from 
the underlying libpcap library. First, we specify HTTP 
(port 80) and HTTPS (port 443) to see only web traffic. 
Then we restrict our interest to a specific host.

We then use -w to write out output to a file for later 
perusal with the Wireshark GUI. The last argument 
requests a statistics report and is equivalent to the 
“Follow TCP Stream” function in the GUI. The 
conversation is written to the terminal when we end 
the capture (Ctrl+C).

It’s in the air
It’s quite likely that the traffic you want to analyse is 
wireless and doing so is entirely possible but a little 
more difficult than sniffing copper.

If you capture packets from a wireless interface, 
you’ll only see data after connecting to the wireless 
network and then only what’s intended for your 
interface (promiscuous mode has no effect). But 
there’s more – the wireless network protocol, called 
IEEE 802.11, uses its own data packets to operate the 
network, and you can see these as well as all the data 
belonging to other users of the network. You just need 
a wireless interface that can be put into a special 
“Monitor” mode.

Many interfaces don’t allow monitor mode but 
some allow a second device node to be created called 
a “Radio Tap”. One such interface commonly found in 
laptops is the Intel Pro Wireless 2200 that uses the 
“ipw_2200” Linux kernel driver. If you have one of 
these, you can enable a radio like this:
# echo 1 > /sys/class/net/wlp6s10/device/rtap_iface
# cat /sys/class/net/wlp6s10/device/rtap_iface
rtap0
# ip link set rtap0 up

You can then capture all wireless data from the 
radiotap device (rtap0 in the example).

Most wireless traffic is usually encrypted, and you 
need to supply the passphrase to decrypt it. The -o 
command-line option allows various options to be set, 
and we can use this to supply these credentials. The 
following example demonstrates this with a sample 
capture file that you can download:
$ curl -o sample.pcap ‘http://wiki.wireshark.org/SampleCaptures
?action=AttachFile&do=get&target=wpa-Induction.pcap’
$ tshark -nr sample.pcap -o wlan.enable_decryption:TRUE -o 
“uat:80211_keys:\”wpa-pwd\”,\” Induction:Coherer\”” -Y “http”

The capture is from a wireless network called 
“Coherer” that has a WPA2 passphrase of “Induction”. 
The options we set enable decryption and supply 
those credentials. The values given in these 
arguments are those you’d see if you looked at the 
preferences stored in the ~/.wireshark directory that 
Wireshark creates. You’ll find the wlan values in a file 
called preferences. The uat (User Access Tables) 
values are different – you’d find those values in the 
specified file which, in this example, is 80211_keys. 

If there is a preferences directory on the machine 
running tshark then it will use it. You may find it easier 
to configure Wireshark to your requirements and then 
copy the preferences directory to where you want to 
run your capture. See the “IEEE 802.11” panel on the 
Wireshark preferences screen. Decryption is only 
possible if you capture the authentication handshake, 
so you need to start capturing before an endpoint 
authenticates with the access point.

Other tools
The library that Wireshark and many other tools rely on 
for packet capture is libpcap. It originated as part of a 
command-line packet analyser called tcpdump that’s 
been the long-standing capture tool of choice on 
UNIX-like systems. You can use tcpdump instead of 
tshark or dumpcap for packet capture; it understands 
fewer protocols but is more likely to be available on a 
UNIX-like system without installing additional 
packages, so it’s worth knowing about. You can pipe 
its output over SSH to view in Wireshark; follow our 
earlier examples but replace the tshark command:
tcpdump -U -s0 -w - “port !22”  

Real uses

Network sniffing might, at first, appear to be a nefarious 
activity, but there are legitimate reasons to do so. Here are 
some examples of things you might find:

  Consumers of unwanted network bandwidth.
 Malware.
  Misconfigured network devices.
  Inappropriate network traffic (hack attempts, etc).

John Lane provides technical solutions to business 
problems. He has yet to find something that Linux can’t 
solve.

PRO TIP
Beware the permissions 
set on your Wireshark 
preferences files, 
especially those 
containing encryption 
keys, because they’re 
world-readable by default!

tshark can capture 
packets, filter them and 
write to a file. When it’s 
done, it can output details 
of the capture. Here we see 
the beginnings of a web 
request.
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The recent Mobile World Congress in 
Barcelona had a lot of good success 
stories for Linux, one of the coolest may 

be the “Runcible” (Edward Lear would have been 
proud), a sort of round not-a-phone, not-a tablet, 
bigger-than-a-watch. The idea behind it is 
apparently to challenge the conventional 
aesthetic of modern mobile gadgets. Well, job 
done! It seems to run on the Firefox OS, which is 
of course Linux, as it runs on a Linux kernel.

Cyanogen also had loads of new 
announcements. This must be one of the most 
exciting new open source startups for some time 
– growing from an online community of 
modders to a hugely popular alternative to 
Android, and now a fully-fledged company with 
partners choosing Cyanogen over Android in the 
first place. It will be fascinating to see the take-up 
of the Alcatel Hero 2+, which will ship with 
Cyanogen OS installed, and not a Google app in 
sight. Things like Maps, Google Play, Hangouts 
etc will necessarily be missing, so we might get a 
taste of how much of Android’s draw is the 
ecosystem rather than the interface.

The old stalwart WebOS was still in evidence 
too, not only on a selection of TVs, but also on 
some new, more conventional, watch prototypes.

These things are all Linux (even Android), 
which is good. But are they Linux enough? It is 
one thing having a watch that runs Linux, but if 
you can’t hack together a Bash script to pipe 
filtered IRC notifications to it, is it really Linux? I 
suggest we start a Campaign for Really Useful 
Linux. At the bare minimum, in addition to a 
Kernel,  a really useful Linux OS ought to have a 
terminal. You know where you are with a 
terminal (usually somewhere in the 80s,  
but in a good way). Future gadget makers  
take note…

Nick Veitch  
was the original editor 
of Linux Format, a 
role he played until he 
got bored and went 
to work at Canonical 
instead. Splitter! 

Free software generalist, currently doing QA for Ubuntu.

Mister Spooky 
(and friends).

Walls of text

Treadmill desk for 
staying fit during 
the cold winters and 
hot summers.

My other half 
hard at work 
(together, we’ll 
save the world!).

Ever-growing stack 
of Ubuntu phones 
(six so far).

Happy Hacking 
keyboard, USB 
touchpad, and x2x for 
dual-screen input.

What version of Linux are you 
using at the moment? 
Ubuntu! It’s good on the desktop, 
and excellent as a server.

And what desktop are you using? 
Unity, presumably…
Sawfish, because it’s the only 
real-time programmable UI I’ve 

found that can handle 300+ simultaneous 
windows (useful if you only log out once 
or twice per year).

What was the first Linux setup 
you ever used?
Slackware 96, then Red Hat, Debian, 
and now Ubuntu. Tried many others 

along the way. In nearly two decades of 
doing free software for a living, there have 
been a lot of adventures…  from making 
last-mile mesh networks high-up on radio 
towers to building a working prototype of 
DARPA’s next deep-sea unmanned 
submarine, from teaching Eskimos how to 
make a meagre living on the internet to 
getting paid for breaking multi-million 

dollar servers. 
These days, I find myself tearing apart 

brand-new Ubuntu phones to find bugs 
and measure performance, while also 
trying to build the technological plumbing 
for community efforts both inside and 
outside of Canonical.

What Free Software/open source 
can’t you live without?
Urxvt, zsh, Dillo, Vim and Python.  
Lightweight and powerful! They 

account for about 90% of my windows 
and 90% of my code.

What do other people love but 
you can’t get on with?
Full desktop environments (Gnome, 
KDE, etc), Systemd, and anything 

else which doesn’t follow the UNIX 
philosophy. I get the feeling the future is 
going to be even more interesting than 
what we’ve already been through. We 
survived the prelude… but with free 
software becoming a major force in the 
world, the real story is just beginning.  
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